<table>
<thead>
<tr>
<th><strong>Contacting Rockwell Automation</strong></th>
<th>Technical Support Contact Information found at: <a href="http://support.rockwellautomation.com/contactinformation/">http://support.rockwellautomation.com/contactinformation/</a></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On-Site Support</strong></td>
<td>Emergency Service in the US call (all hours): 1-800-800-0522&lt;br&gt;Emergency Service outside the US (all hours): Contact your local sales office. *&lt;br&gt;Learn more about emergency/scheduled callout at: <a href="http://support.rockwellautomation.com/SupportPrograms/default.asp">http://support.rockwellautomation.com/SupportPrograms/default.asp</a></td>
</tr>
<tr>
<td><strong>Copyright Notice</strong></td>
<td><strong>for sales office nearest you visit</strong> <a href="http://rockwellautomation.com">http://rockwellautomation.com</a> and click on the locations link.</td>
</tr>
</tbody>
</table>
Important Disclaimers

Because of the variety of uses for the products described in this publication, those responsible for the application and use of this control equipment must satisfy themselves that all necessary steps have been taken to assure that each application and use meets all performance and safety requirements, including any applicable laws, regulations, codes and standards.

The illustrations, charts, sample programs and layout examples shown in this guide are intended solely for purposes of example. Since there are many variables and requirements associated with any particular installation, Rockwell Automation does not assume liability (to include intellectual property liability) for actual use based upon the examples shown in this publication.

Reproduction of the contents of this copyrighted publication, in whole or in part, without written permission of Rockwell Automation is prohibited.
# Contents

**Chapter 1: Basic Configuration**  
Accessing the home page  
9300-8EDM home page  
Set IP address  
Set security  
Miscellaneous  

**Chapter 2: Network Services Setup**  
IGMP Configuration  
DHCP Configuration  
DHCP Address Table  
MAC Address Labels  
Email Configuration  
SMS Configuration  
Send an Email from PLC  
Send SMS from PLC  
Change SMTP server in Logix Program  
Email and SMS Error Codes  

**Chapter 3: Diagnostics**  
Display Switch Counters  
IGMP Report  
MAC Address Report  
Alarm Setup  
Controller Restart  
PLC Configuration  
Automatic Email Alerts  
Email Queue Status  
Firmware Upgrade  

**Chapter 4: Switch Management**  
Port Configuration  
Mirror Configuration  
MAC ID Management  
VLAN Setup  
QoS Setup  

**Appendix A**  
Upgrading 9300-8EDM Firmware  
Complete flash procedure for the 9300-8EDM
Appendix B
Username and Password Rules
Characters that cannot be used, length, and recommendations 46

Appendix C
Factory Reset
Setting the 9300-8EDM to Factory Default settings 47

Appendix D
Data Layout
I/O Table for the 9300-8EDM 48

Appendix E
Adding the 9300-8EDM into Logix5000 v.13 and under
Instructions for adding the 9300-8EDM to a Logix program 49

Appendix F
Adding the 9300-8EDM into Logix5000 v.15 and greater 52

Appendix G
Downloading Configuration
Instructions for uploading configuration information to a PC and
Downloading configuration from a PC to a 9300-8EDM
IMPORTANT

This manual assumes that the user is familiar with all procedures in the Quick Start guide. If you have not already done so, please read through the Quick Start Guide before referencing this publication.

The following Documents can be found at www.ietf.org. The Internet Engineering Task Force produces the following documents:

**RFC**: (Request for Comments) public documents on many networking topics and protocols.

**STD**: Internet Standards Documents

**BCP**: Best Current Practices Documents

**FYI**: Informational Documents

These documents will be occasionally referenced throughout this manual.
1 Basic Configuration

This Chapter covers:
- Management Interface information
- The Home page
- All items under the “Basic Configuration” menu option
  - Setting the IP address
  - Setting the security
  - Miscellaneous
  - Setup

Accessing the Management Interface

Before the Management Interface can be accessed, a connection must be established with the 9300-8EDM. (see the Quickstart guide for further instruction)

Once the connection is established, open your web browser.
1. Type http://XXX.XXX.XXX.XXX into the address bar and hit Enter.
   Replace the X’s with your 9300-8EDM IP address. (192.168.1.1 by default)
2. Username is left Empty and the password is ZYPCOM

If the Web Browser won’t open:
1. verify the IP address of the 9300-8EDM (192.168.1.1 by default)
2. verify your connection setup (see Quick Start for further guidance)
3. verify that the 9300-8EDM has power (green pwr LED is on)
4. verify that the cable is connected (do you see a green or yellow LED lit on the Ethernet port.
5. verify that a proxy server is not preventing you from accessing the 9300-8EDM
Device Name:
Possible values are: user programmable
Default value is: Milwaukee, WI
Identifies the unit (see Basic Configuration, Miscellaneous for instructions on changing the unit’s name)

Port Mirroring:
Possible Values are: Enabled, Disabled
Default Value is: Disabled
Allows traffic on one port, to be copied and sent (mirrored) to another port to allow an Ethernet sniffer to capture it. For more on Port Mirroring see Chapter 4.

IGMP Snooping:
Possible Values are: Enabled, Disabled
Default Value is: Disabled
Filtering mechanism for multicast traffic, should be used when I/O is running on Ethernet. For more on IGMP Snooping see Chapter 2

QoS:
Possible Values are: Enabled, Disabled
Default Value is: Disabled
When enabled, the switch can prioritize packet delivery to a certain port or MAC address. DO NOT USE ON CONTROL NETWORKS!!!

VLAN:
Possible Values are: Enabled, Disabled
Default Value is: Disabled
VLAN (Virtual LAN) can be used to eliminate traffic caused by Multicast and Broadcast Ethernet traffic. With this feature, we can partition the switch ports into different private domains.

**MAC ID Management:**
Possible Values are: Enabled, Disabled
Default Value is: Disabled
Determines if a MAC ID is authorized on the network by checking the allowed MAC IDs, and notifies the PLC when an unauthorized node appears on the network.

**Product Type:**
The part number of the device, should always be 9300-8EDM

**Serial Number:**
Unique to every unit (ex. 3A1138111)

**Firmware Revision:**
Check our website to make sure you are up to date. Updates product firmware, the web interface must be updated separately.
http://support.rockwellautomation.com/modem

**Web Revision:**
Check our website to make sure you are up to date. This file will update your web interface only.
http://support.rockwellautomation.com/modem

**Uptime:**
This setting indicates the units running time. This timer is reset when the unit is powered up.

**The Switch Port Section:**

```
Port 8  Port 7  
Port 6  Port 5  
Port 4  Port 3  
Port 2  Port 1  
```


Link:
Possible Values: ON (Green LED flashing with data traffic), OFF
On if a device is connected to the port and has power

**Speed:**
Possible Values: 10 (green LED), 100 (orange LED)

**Duplex:**
Possible Values: Full, Half

**Gigabit Port:**
This is offered as an option to the unit and requires a pluggable SFP MSA compliant transceiver that must be purchased separately. A fiber optic transceiver can be used to connect to a fiber network backbone. Information about the transceiver used, and the connection speed can be found on the home page.

**The Resources section:**
Provides Links to our website and this manual (you will have to be connected to the Internet to reach our website). The Technical reference manual link in this section does not require an Internet connection because it is embedded in the product. For convenience we have also embedded the EDS file for this device under the EDS file link in this section. Download it and install it with the EDS Hardware Installation Tool (one of the RSLinx Tools).

**Contacts:**
Contact Info can be filled in by selecting Basic Configuration>Miscellaneous. This allows the user to enter a Name or Phone number and email address of the appropriate contact person.

**Set IP address**

Changing your IP address will probably be necessary to install the 9300-8EDM into your Ethernet network. Follow the following steps to change the IP address.

1. Find an available IP address on your subnet
2. Establish a connection with the 9300-8EDM
3. Click on the “Basic Configuration” Folder
4. Click “Network Configuration”
5. Your screen should appear as follows:

![Network Configuration Screenshot]

6. Enter your new IP address
7. If needed, change the subnet mask and Gateway
8. Turn BOOTP Client off to prevent dynamic IP address assignment
9. If using hostnames on the network, Name Resolution must be turned on and the DNS server addresses must be configured (usually required if using the email functionality)
10. Click “Apply Changes”
11. Once IP and subnet are changed, power MUST be cycled to load the new address

**THE 9300-8EDM WILL NOT LOAD THE NEW IP, AND SUBNET ADDRESS UNTIL POWER IS CYCLED**

Power can be cycled remotely through the Management Interface by:
1. Click the “Diagnostics” folder
2. Click “Controller Restart” (Note: This restarts the 8EDM only, this will not restart the PLC and all communications through the 8EDM will be interrupted)

**Setting IP address with Bootp:**

The 9300-8EDM ships with Bootp client enabled by default. To assign an address simply put the 8EDM on a network with a Bootp Server, and cycle power to the 9300-8EDM. It will attempt to obtain an IP address several times from the server, before timing out and defaulting to the factory preset address: 192.168.1.1
Set Security

We recommend changing the Administrator and Read-Only password before the unit is placed in service. The Administrator password is used for the Management Interface (HTTP session), telnet and the ftp interface (used to upgrade the firmware). The username verified for the ftp session only, the username for the HTTP session is not checked (therefore can be anything). The Read-Only password is used for Read-Only access to the Management Interface (HTTP session). Change your Administrative or Read-Only username and password as follows:

1. Click the “Basic Configuration” Folder
2. Click “Set Security”
3. Change the username and password (see Appendix B for recommendations)
4. Click “Apply Changes”
5. Cycle power to the unit to load the new username and password

The Administrative password applies to Telnet, FTP, and the Web Browser Interface.

THE 9300-8EDM WILL NOT LOAD THE NEW SETTINGS UNTIL POWER IS CYCLED

Miscellaneous

Box Name:
This setting allows you to give your 9300-8EDM a name that describes its location or connected devices. This feature is useful when multiple 9300-8EDMs are installed. The unit reports this name on the Home Page
To change this setting:
1. Click “Basic Configuration” Folder
2. Click “Miscellaneous”
3. Type the new name in the Text Box and click “Apply Changes”
4. The new name will not be shown on the Home page until you hit the Refresh button on the browser

User Inactivity
This setting allows you to change the length of time the Management Interface (HTTP session) will remain open while inactive. Choose anywhere from 0-99 minutes. Selecting a value of 0 = feature disabled, the interface will remain open until it is closed.
Default Value: 3 Minutes
**Status Refresh**
This setting controls the refresh rate of the Management Interface. Choose anywhere from 0-99 seconds.
Value of 0 = Feature Disabled, will not refresh
Default Value: 5 seconds

**Contact Info and Contact Email**
This can be used to identify the responsible service personnel.
Network Services Setup

This Chapter covers:
- IGMP Definition and Configuration
- DHCP Definition and Configuration
- DHCP Address Table
- MAC Address Labels
- Email Configuration
- SMS Configuration

Definitions

UDP: Defined by RFC 1122, section 4.1: The User Datagram Protocol offers only a minimal transport service. UDP is used by applications that do not require the level of service of TCP or that wish to use communications services (e.g., multicast or broadcast delivery) not available from TCP. An application program running over UDP must deal directly with end-to-end communication problems that a connection-oriented protocol would have handled -- e.g., retransmission for reliable delivery, packetization and reassembly, flow control, congestion avoidance, etc., when these are required. This is commonly seen with I/O type devices that will send out information at an RPI rate.

TCP: Transmittion Control Protocol, TCP enables two hosts to establish a connection and exchange streams of data. TCP guarantees delivery of data and also guarantees that packets will be delivered in the same order in which they were sent.

DNS- (Domain Name Server) Translates domain names into IP addresses, for example www.example.com may translate to 192.168.100.100

DHCP- (Dynamic Host Configuration Protocol) Commonly used on office networks, Scarce IP address space is efficiently used because IP addresses are "leased" to clients for a limited time. This lease concept facilitates the recycling of addresses, which is the heart of DHCP.

Bootp- (Bootstrap Protocol) Commonly used with AB Ethernet products, defined by RFC 951, BOOTP protocol is used by a client machine to locate its IP address and network mask.

Domain- A group of computers and devices on a network that are controlled as a unit with common rules and procedures
IGMP Definition and Configuration

IGMP Definition
The 9300-8EDM includes a feature called IGMP snooping. IGMP snooping will sort multicasting devices into groups. This will limit the multicast packets received by hosts that do not need the info, thus making the network more efficient and deterministic.

- broadcast
  Without IGMP snooping an I/O module will act like a broadcasting device and all devices on the subnet will be flooded with I/O traffic

- multicast
  IGMP snooping will filter the I/O traffic from devices that are not in the intended multicast group

- unicast
  A message instruction from one PLC to another would be an example of unicast, it contains one source and one destination address.

When to use IGMP
IGMP should be used when I/O is running on your network. IGMP will help to isolate this UDP traffic to ports that need to receive it. When it is not used, other devices may be slowed down by the continuous flow of UDP packets.

IGMP Configuration
IGMP is configured by enabling it and setting the version and query period. The 9300-8EDM supports version 1 and version 2 IGMP. Determine which version your devices are using and make the appropriate selection. The Query period determines how often your network is queried for Group information, the hosts on your network will respond with their group information. To see your multicast groups, the IGMP report can be found under the “Diagnostics” folder.

IGMP support for Rockwell Products
1756-ENBT (fw 1.4) - version 1
1756-ENBT/B (fw 2.7 and above) – version 2
Note when using Logix version 15 or greater and scanning the 9300-8EDM using the Add on Profile: Settings of the IGMP tab in the profile will overwrite settings made on the HTML management interface. If you are scanning the 9300-8EDM with Logix use the IGMP tab in the add on profile to configure IGMP to avoid confusion. (see appendix F for more information).

DHCP Definition and Configuration
The 9300-8EDM can function as a DHCP/BOOTP server. This is not to be confused with BOOTP/DHCP client which allows the 9300-8EDM to receive and address from a DHCP/BOOTP server.

DHCP/BOOTP Configuration
Dynamic IP address assignment by IP address Pool:
It is important to keep this feature shut off if this device is on a larger IT controlled network. Company networks typically have DHCP servers in place to service the computers on the network with IP addresses. This device may conflict with the existing DHCP servers on the network and prevent them from handing out addresses.
The 9300-8EDM has the ability to serve IP addresses to 32 nodes. We set up the 9300-8EDM as follows:
1. Establish a Connection with the 9300-8EDM
2. Select NETWORK SERVICES SETUP>DHCP CONFIGURATION
3. Enable the DHCP Server by selecting “ON – Assigned from Pool” (Will be off by default)
4. Select your subnet and gateway addresses for the network
5. Select the primary and secondary DNS servers. The domain name should be filled out if the 9300-8EDM resides on a domain
6. Next we assign a pool of address for the 9300-8EDM to pick from.
7. Dynamic bootp should be enabled to answer bootp requests
8. Lease time is only active for DHCP requests, therefore will usually be irrelevant. Bootp will set this value to 49710 days making the address permanent.
9. Cycle power for the changes to take effect

Dynamic IP address assignment by Port:
The 9300-8EDM has the ability to serve IP addresses based on the port the device is connected to. When used properly, this feature can allow easy replacement of Ethernet equipment on the factory floor. We set up the 9300-8EDM as follows:
1. Establish a Connection with the 9300-8EDM
2. Select NETWORK SERVICES SETUP>DHCP CONFIGURATION
3. Enable the DHCP Server by selecting “ON – Assigned by Port” (Will be off by default)
4. Select your subnet and gateway addresses for the network
5. Select the primary and secondary DNS servers. The domain name should be filled out if the 9300-8EDM resides on a domain
6. Next we assign an IP addresses to all ports
7. Lease time is only active for DHCP requests, therefore will usually be irrelevant. Bootp will set this value to 49710 days making the address permanent.
8. Cycle power for the changes to take effect

Note: If multiple devices are connected to a port (uplink to another switch) the IP address will be sent to the first device to request it from the port. If a field is set to an address of 0.0.0.0 a DHCP request on the port will be ignored.

Most applications with PLCs will not require the DNS, Domain name, and lease time fields to be changed. If these functions do not apply to your network, leave these fields at their default value.

Hint:
When Ethernet/IP certification is requested from the ODVA each product must get a Unique Product Code (ex. A 1794-AENT would have a product code of 90). This can be checked with a Get Attribute Single MSG instruction and compared to verify a generic device that does not use keying. This number would be unique to the product line not the individual device (like the MAC ID). This will help verify that the Logix Controller is talking with the correct device.
DHCP Address Table
The DHCP Address Table is populated when the server is set to assign an IP address from a pool. This table will detail which IP address is assigned to a device (by MAC ID).

MAC Address Labels
This section allows the 9300-8EDM user to associate a “user-friendly label” to a MAC ID within the 9300-8EDM user interface. When a label is associated with a MAC ID it will be reflected in the MAC ID table and the MAC ID management interface.
This feature eases troubleshooting a network. The labels are reflected in the MAC Address Report (see above) and the MAC ID Management Configuration screen (see above).

**Email Configuration**

The 9300-8EDM includes an embedded email client that uses an email relay server or gateway message server to send email and/or text messages to a mail recipient, mobile telephone, or portable wireless device.

The network gateway address and DNS information must be entered. This setup is only required once and is stored in the 9300-8EDM’s non-volatile memory. See page 10 for help setting up the network addresses. For help locating these IP addresses see your network administrator.

---

**Note:**

If you do not intend to use symbolic names (e.g. smtp@yahoo.com) but rather IP addresses only to access your mail server, you can leave the DNS configuration empty.

The SMTP server parameters are setup on the Email Configuration page.

- Click on the Network Services Setup tab and then select Email Configuration.
- Enter your SMTP server name or IP address in the field labeled IP or Hostname.
- If authentication is used, (required by most ISPs) click the SMTP Authentication check box and then enter your user name and password.
  - Basic authentication, compatible with POP servers, is supported. The name and password entered here are those associated with your outgoing email account.

Now you can test sending an email message from the Send an Email web page. Make sure that the 9300-8EDM is connected to a network that has access to your email server. This may require access to the internet.
Note: A status message providing the result of this operation will be displayed at the bottom of the page. Detailed error descriptions will allow you to easily identify a potential problem.

SMS Configuration
If you intend to use an SMS gateway service to send text messages to a mobile telephone or portable wireless device, click on the SMS Configuration tab and enter the email address of your SMS gateway provider. Enter this address in the SMS GW Server field, then fill in your account ID. Enter your user name and password.

Note: Most newer cell phones will except email directly, if your phone accepts email you do not need to use an SMS gateway service to get text messages from the 9300-8EDM. See your Cell phone providers web site to get the email address of your cell phone.

This setup is also tested using the Send an Email page. The To: field will be the phone number of the device to receive the message.

Sending an Email via a Controller-Initiated Message Instruction
A Logix controller can send a generic CIP message instruction to the Ethernet diagnostic module that instructs the 9300-8EDM to send an email message to a
SMTP email server using the standard SMTP protocol. This is useful to communicate controller data, network alerts, and/or application conditions to appropriate personnel.

You need two controller-scoped string tags. One tag contains the email text and the other contains the status of the email transmission (the result code). These tags contain as many as 520 characters. You must first create a user-defined STRING data type (the default STRING data type in RSLogix 5000 software is not large enough for most email text). For example, create a string data type named EmailString. Next, create one controller-scoped tag of this new data type to contain the email text named EDM_EMAIL. Create a second controller-scoped tag of this new data type to contain the transmission status named EmailDstStr. Both of these tags are of type EmailString.

- Open your RSLogix program and go to Data Types, Strings. Create EmailString type. Note the initial LEN field. When you edit this tag its length will be automatically inserted by the RSLogix editor. When sending email with MSG instructions the length of the LEN field must be added to the string length. For more details see the RSLogix program example.
• Open tags and select the Edit tab. Insert EDM_EMAIL and EmailDstStr. Both tags are of the type EmailString. These tags can be also created later when the MSG instruction is inserted. The text of the email does not have to be static. You can program a controller project to collect specific data to be sent in an email. For more information on using ladder logic to manipulate string data, see the Logix 5000 Controllers Common Procedures Programming Manual, publication 1756-PM001.

• Create a tag of the type MESSAGE. Our example uses a tag named SendEmail_EDM. Set the message type to generic CIP, service code 4b, object class 32f, instance 1, attribute 0. The source length is the length of the string in the EDM_EMAIL tag + 4.
It is very important to enter the correct communication path. Click on the Communication tab and then the Browse button. Select the name associated with your 9300-8EDM from the I/O tree and then click Apply. In this example the name is Zypcom_Test_Unit. For more information on configuring the path of a MSG instruction, see the Logix Controllers General Instructions Reference Manual, publication 1756-RM003.

- If an error occurs, you will see the Error Code (Extended Error Code). The result code from the SMTP server is stored in the EmailDstStr tag.

See page 32 for a table of status codes.
Open your routine window (e.g. MainRoutine) and insert a MSG instruction. Select the SendEmail MESSAGE tag. Now you can double click on the MSG block and select source (EDM_EMAIL) and destination (EmailDstStr) tags.

In our example there are also GetAttributeValue and SetAttributeValue tags and GetAttribute / SetAttribute MESSAGE tags for individual attribute handling.

Message sending is triggered by the trigger_send BOOL tag. The message is sent when you press Ctrl-T in the rung or if you set the tag value to 1.

An example of a program that sends an email when any unauthorized MAC is detected by the 9300-8EDM is shown here:
**Entering the text of the email**

Use the string browser to enter the text of the email. In the example above, you enter the email text into the EWEB_EMAIL tag. To include “To:”, “From:”, and “Subject:” fields in the email, use `<CR><LF>` symbols to separate each of these fields. The “To:” and “From:” fields are required; the “Subject:” field is optional. Use a second set of `<CR><LF>` symbols after the last one of these fields you enter. For example:

```
To: email address of recipient $r$l
From: email address of sender$r$l
Subject: subject of message $r$l$r$l
body of email message
```

The maximum length of an email message is 520 characters. An additional 4-byte string-length value is added to the tag. As a result, the maximum source length is 524 characters.

**Note:** `<CR><LF>` characters are coded as `$r$l`: 

![String Browser - EDM_EMAIL](image)
Sending an SMS from the PLC

Text messages are sent in the same way as a normal email message. The only difference is the recipient in the “To:” field is a telephone number instead of a normal email address.

The email format for sending text messages using a SMS gateway service is shown below:

```
api_id:nnnnnnnn$r$l
user:xxxxxx$r$l
password:pppppp$r$l
to:cell_phone#$r$l
text:Simple text$r$l
text:on all$r$l
text:3 lines. $r$l
text:Sms signature - 1234567890123456$r$l
```

Modifying the SMTP Server Setup within a PLC Program

You can modify the SMTP server through which emails are sent by setting class 32f, attribute #5.

Note: Set Attribute Single uses service code 10:
Email and SMS Error Codes
Examine the destination element of the email MSG to see whether the email was successfully delivered to the mail relay server. This indicates that the mail relay server placed the email message in a queue for delivery. It does not mean the intended recipient successfully received the email message. Possible codes that could be in this destination element are:

<table>
<thead>
<tr>
<th>Error Code (hex):</th>
<th>Extended-Error Code (hex):</th>
<th>Description:</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x00</td>
<td>none</td>
<td>Delivery successful to the mail relay server.</td>
</tr>
<tr>
<td>0x02</td>
<td>none</td>
<td>Resource unavailable. The email object was unable to obtain memory resources to initiate the SMTP session.</td>
</tr>
<tr>
<td>0x08</td>
<td>none</td>
<td>Unsupported Service Request. Make sure the service code is 0x4B and the Class is 0x32F</td>
</tr>
<tr>
<td>0x11</td>
<td>none</td>
<td>Reply data too large. The Destination string must reserve space for the SMTP server reply message. The maximum reply can be 470 bytes</td>
</tr>
<tr>
<td>0x13</td>
<td>none</td>
<td>Configuration data size too short. The Source Length is less than the Source Element string size plus the 4-byte length. The Source Length must equal the Source Element string size + 4</td>
</tr>
<tr>
<td>0x15</td>
<td>none</td>
<td>Configuration data size too large. The Source Length is greater than the Source Element string size plus the 4-byte length. The Source Length must equal the Source Element string size + 4</td>
</tr>
<tr>
<td>0x19</td>
<td>none</td>
<td>Data write failure. An error occurred when attempting to write the SMTP server address (attribute 4) to non-volatile memory.</td>
</tr>
<tr>
<td>0xFF</td>
<td>0x0100</td>
<td>Error returned by email server; check the Destination string for reason. The email message was not queued for delivery</td>
</tr>
<tr>
<td>0x0101</td>
<td>SMTP mail server not configured. Attribute 5 was not set with a SMTP server address.</td>
<td></td>
</tr>
<tr>
<td>0x0102</td>
<td>&quot;To:&quot; address not specified. Attribute 1 was not set with a &quot;To:&quot; address AND there is not a &quot;To:&quot; field header in the email body</td>
<td></td>
</tr>
<tr>
<td>0x0103</td>
<td>0x0103 &quot;From:&quot; address not specified. Attribute 2 was not set with a &quot;From:&quot; address AND there is not a &quot;From:&quot; field header in the email body.</td>
<td></td>
</tr>
<tr>
<td>0x0104</td>
<td>Unable to connect to SMTP mail server set in Attribute 5. If the mail server address is a hostname, make sure that the device supports DNS, and that a Name Server is configured. If the hostname is not fully qualified, i.e., &quot;mailhost&quot; and not &quot;mailhost.xx.yy.com&quot; then the domain must be configured as &quot;xx.yy.com&quot;. Try &quot;ping &lt;mail server address&gt;&quot; to insure the mail server is reachable from your network. Also try &quot;telnet &lt;mail server address&gt; 25&quot; which attempts to initiate a SMTP session with the mail server via telnet over port 25. (If you connect then enter &quot;QUIT&quot;).</td>
<td></td>
</tr>
<tr>
<td>0x0105</td>
<td>Communication error with SMTP mail server. An error occurred after the initial connection with the SMTP mail server. See the ASCII text following the error code for more details as to the type of error.</td>
<td></td>
</tr>
<tr>
<td>0x0106</td>
<td>SMTP mail server host name DNS query did not complete. A previous send service request with a host name as the SMTP mail server address did not yet complete. Note that a timeout for a DNS lookup with an invalid host name can take up to 3 minutes. Long timeouts can also occur if a domain name or name server is not configured correctly.</td>
<td></td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>--------</td>
<td>------------------------------------</td>
<td></td>
</tr>
<tr>
<td>0x0107</td>
<td>No DNS entry</td>
<td></td>
</tr>
<tr>
<td>0x0108</td>
<td>DNS not configured</td>
<td></td>
</tr>
<tr>
<td>0x0109</td>
<td>GW not configured</td>
<td></td>
</tr>
<tr>
<td>0x0110</td>
<td>System fail (Socket error)</td>
<td></td>
</tr>
</tbody>
</table>
This Chapter covers:
- Displaying switch counters
- IGMP report
- MAC address report
- PLC configuration
- Controller Restart
- Alarm Setup
- Automatic Email Alerts
- Email Status Queue
- Firmware Upgrade

Displaying Switch Counters

This option will give you various counts from the switch. All counters are displayed in Hex.
Octet = 8 bits

**TX counters**

**Tx Octet Count**
Total of transmitted good octets from the selected port

**Tx Drop Pkts Count**
Packet is not acknowledged by the receiving host

**Tx BroadcastPkts Count**
Number of good packets sent w/ destination of everyone. Receivers are unspecified

**Tx MulticastPkts Count**
Packets sent to members of multicast group. One terminal to many hosts

**Tx UnicastPkts Count**
In contrast with multicast, consist of one terminal transmitting to one host

**Tx Collisions Count**
Two terminals transmit packets at the same time causing them to collide, Collision Count should be very low, collisions could indicate a faulty device on the network.

**Tx SingleCollision Count**
Packet collides with one other terminal’s transmitted packet

**Tx MultipleCollision Count**
Packet collides with more than one terminal’s transmitted packets

**Tx DeferredTransmit Count**
Number of packets delayed because the network is busy (Higher the number the less deterministic your network)

**Tx LateCollision Count**
Collision is detected later than the 512 bits into the packet transmission

**Tx ExcessiveCollision Count**
Packets not transmitted because the packet experienced 16 failed attempts

**Tx FrameInDisc Count**
Network Device is not acting in compliance with a flow control request

**Tx PausePkts Count**
Pause frames sent by this port

**RX counters**

**Rx Octets**
Total good octets received on selected port

**Rx Undersize Pkts**
Good packets that are under 64 octets long

**Rx Pause Pkts**
Pause packets received by this port

**Pkts64 Octets**
Data packets = 512 bits

**Pkts65to127 Octets**
Data packets = 520-1016 bits

**Pkts128to255 Octet**
Data packets = 1024-2040 bits

**Pkts256to511 Octet**
Data packets = 2048-4088 bits

**Pkts512to1023 Octet**
Data packets = 4096-8176 bits

**Pkts1024to1522 Octet**
Data packets = 8192-12176 bits

**RxOversize Pkts**
Packets over 12176 bits or 1523-1536 Octets

**RxJabbers Pkts**
Packets longer than 1522 Octets, and have an error, usually caused by a faulty device

**RxAlignment Errors**
Packets between 64 and 1522 octets, and have an error

**RxFCS Errors**
Packets received (between 64-1522 octets) with FCS (frame check sequence) not matching

**RXGoodPkts**
Octets received with no errors
**RxDrop Pkts**
Packets dropped due to lack of resources (bandwidth, input buffer)

**RxUnicast Pkts**
Unicast packet received (only 1 receiving host)

**RxMulticast Pkts**
Multicast packets received (many receiving hosts)

**RxBroadcast Pkts**
Received by all hosts on the network

**RxSACChages**
Number of times the Source address of a good packet has changed value. A count greater than 1 indicates a repeater based network

**RxFragments**
Packets received less than 64 octets

**RxExcessSizeDisc**
Packets received greater than 1536 octets and discarded due to excessive length.

**RxSymbolError**
Invalid data symbol detected

**IGMP Report**
IGMP protocol adds a group number to a transmitted packet. Only hosts in that IGMP group will receive the packet. The IGMP protocol prevents a multicast packet from behaving like a broadcast (transmitted to all network hosts). The switch manages the task of forming a table of IGMP groups and hosts belonging to those groups. The table can be displayed by selecting Diagnostics>IGMP report

**MAC Address Report**
All Ethernet equipment has a MAC address (hardware address). These can be displayed by selecting Diagnostics>MAC address report. A pool of MAC addresses are assigned to each Ethernet product manufacturer. For example, Allen Bradley Ethernet equipment MAC addresses usually begin with 00:00:BC.

**Alarm Setup**
Alarm setup is used to see the bandwidth on each port; the bar will turn red when the bandwidth is out of range.
### Scaled Bandwidth Utilization

<table>
<thead>
<tr>
<th>Port</th>
<th>0%</th>
<th>100% Actual</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port 1:</td>
<td>0%</td>
<td>100</td>
<td>0</td>
</tr>
<tr>
<td>Port 2:</td>
<td>0%</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Port 3:</td>
<td>7%</td>
<td>15080</td>
<td>0</td>
</tr>
<tr>
<td>Port 4:</td>
<td>0%</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Port 5:</td>
<td>0%</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Port 6:</td>
<td>0%</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Port 7:</td>
<td>3%</td>
<td>16280</td>
<td>0</td>
</tr>
<tr>
<td>Port 8:</td>
<td>0%</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

### Configuration

- **Bandwidth Alarm**: Disabled
- **Scaling Factor**: 1000 [Range: 1-65535]
- **Time Factor**: 1 [Range: 1-30 [min]]
- **Allowed Traffic Difference**: 50 [Range: 10-1000] [

### Refresh

Used to refresh your screen with the latest information, the screen will automatically refresh at the rate configured under Basic Configuration>Refresh Rate.

### Save Traffic Reference

Used as a benchmark for the system network. Click this button when the network is running as it should in production. The 9300-8EDM will calculate the difference between the reference point and the current levels of traffic for each port. If it varies to an alarm state it will send an input to the PLC indicating the port number. (See Appendix D For the complete I/O table for the 9300-8EDM)

### Bandwidth Alarm

Disabled by default, when enabled will calculate the difference between the reference point of the network and the current rate of traffic. If a variation,
exceeding the allowed traffic difference, occurs it sends an input to the PLC indicating the port number that the bandwidth issue is occurring.

**Scaling Factor**
Most applications will have such a small amount of traffic that the bandwidth will only be a fraction of a percent. The scaling factor allows a more visual representation of the traffic on each port. See the detailed information link on the alarm setup screen for more information on how the bandwidth is calculated.

**Time Factor**
The length of time packets are counted to determine the bandwidth percentage for each port. (See the detailed information link on the alarm setup screen for more information on how the bandwidth is calculated)

**Allowed Traffic Difference**
The percentage that the current traffic level can vary in either direction, from the stored reference value, before an input is sent to the PLC.

**Controller Restart**
This selection will restart the 9300-8EDM. It is useful when making configuration changes. The 9300-8EDM must be restarted for some changes to take effect.

**PLC Configuration**
Read only information about the 9300-8EDM, relating to the PLC connection: EDS filename, Multicast address used by the 9300-8EDM, Status information on the 9300-8EDM

**Automatic System Alerts**
The 9300-8EDM may also be configured to automatically send system alert messages via the email client to a recipient’s email address, mobile telephone, or portable wireless device. This can be useful in a critical control network to alert network personnel of a problem in the network as it occurs. Events in the network like unauthorized MAC ID’s, bandwidth utilization alarms, or port down can be communicated automatically to the responsible supervisor.

To enable this capability, click on the Diagnostics tab and select Automatic Alerts. The alert page will open. You can enter up to six different email addresses or mobile telephone numbers in the Recipients list. After you have finished this, click Save Recipients. Next, select which alerts you want to automatically trigger a message by clicking on the check box next to the alert. You can select any number of automatic alerts from the list. When you’ve
finished your selection enable Automatic Alerts at the top of the page and click Apply Changes.

The screen below shows the Automatic Alert setup page:

---

**Email Queue Status**

Gives status on email queue, including: # of emails sent successfully, any dropped messages, and pending messages.
Firmware Upgrade
Upgrade firmware of the 9300-8EDM in one of two ways: using the 9300-RADES configuration utility (described in appendix A), or with this web page.

Upgrade Procedure Description
1) Unpack the zip file containing the new firmware to a temporary directory on your computer’s hard drive.
2) Click the “Browse” button, below, find the location of the boot.img file. Select the file and click “Open”. Then click the “Upgrade” button, below. You will be prompted to enter the administrator User Name and Password if you have not already done so. When the upgrade is complete, the device will be automatically restarted.
3) If the firmware upgrade included a new webdata.img file, repeat this process by selecting the file from your hard drive and clicking on the “Upgrade” button, below.
4) Repeat this process a third time if the firmware upgrade included a new User’s Guide document file. Select the file named qsddata.img and repeat the process. This completes the upgrade process.

Firmware Upgrade
New Firmware File
Browse...
Upgrade
4 Switch Management

This Chapter covers:
- Port Configuration
- Mirror Configuration
- MAC ID Management
- VLAN setup
- QoS setup
- Display Counters

Port Configuration
This device auto-negotiates most of its settings to ease the configuration process. However, these settings can be manually set by using this menu option.

TX/RX
Default: Both
Choices: None, TX, RX, Both
Controls communications on the selected port

Negotiation
Default: Auto
Choices: None, Auto
Turn off auto-negotiation here if the port is to be manually configured

Rate
Auto-negotiates 10 or 100 mbit/second based on the connected device, must be manually selected if the negotiation parameter is changed to none

Duplex mode
Auto-negotiates half or full based on the connected device. Must be manually selected if the negotiation parameter is changed to none

Flow Control
Default: On
Prevents port buffers from over filling
Port Mirroring
Default: Disabled
Allows traffic on one port, to be copied and sent (mirrored) to another port to allow an Ethernet sniffer to capture it.

Quality of Service
Default: Disabled
When enabled, the switch can prioritize packet delivery to a certain port or MAC address.

IGMP snooping
Default: Disabled
When enabled, it sorts Multicast packets into groups and delivers them to the appropriate group.

Mirror Configuration
This section configures the rules or filters for port mirroring. Filters can be configured to only capture packets from certain devices (MAC addresses). We can also filter to capture packets with a certain destination address.

To enable port mirroring follow these two steps:
1. Enable Port Mirroring by selecting Switch Configuration>Mirror Configuration
2. Configure the Ports by selecting Switch Configuration>Port Configuration
Setting Up the Ports:
Default: None
Choices: IN, OUT, BOTH, NONE
In: mirror incoming traffic, Out: mirror outgoing traffic,
Both: mirror both directions, Capt: capture mirrored traffic
The above selections are port based.

Optional Port Mirroring Parameters
Includes: Setting up filters and Setting up a divider. (See below)
Setting Up the Filter:
Two filters need to be configured, the Input (Ingress Mirror Filter) and the Output (Egress Mirror Filter)
Default: All Transmitted
Choices: All Transmitted, All Transmitted frames with Destination Address equal to the MAC address field, All Received frames with Source Address equal to the MAC address field

Setting Up the Divider:
The Divider allows further filtering

Example: Port 4 is set up to CAPTURE Port 3’s incoming frames.
The Input Filter is set to capture traffic with Source Address 00:00:BC:03:4E:08. The Input Divider is set to 2, to capture every other frame coming to port 3 with Source address of 00:00:BC:03:4E:08, this MAC address belongs to IP address 100.100.101.2.
Once the Mirror configuration is complete, you can then look at the packets with Ethernet Sniffer Software.

**Important Note:** Port Mirroring and IGMP snooping are mutually exclusive. When Port Mirroring is enabled IGMP snooping is disabled. Port mirroring is a diagnostic tool; this feature should be disabled while running in a production environment.

**MAC ID Management**
Used to manage Ethernet devices that connect to the network, allows stricter control of the Ethernet network without the use of special Ethernet management software.

**MAC ID Management**
Possible Values: Enabled, Disabled
Default Value: Disabled
Used to enable this feature and send inputs to the PLC indicating unauthorized access to the network.

**Apply Changes**
Click this button to finalize any changes made to this page.

**Learned MAC Addresses**
This table lists the MAC IDs detected on the network by the 9300-8EDM. The port number and MAC ID are shown for each device detected on the network. This list is built automatically by the 9300-8EDM.

**Authorized MAC Addresses**
This list indicates which MAC IDs are allowed on the network. This list must be created by the user. Whenever a new device comes online, this list is checked to determine if it is authorized. If the device is not authorized, an input is sent to the PLC. (See Appendix D for the I/O table of the 9300-8EDM)

**Authorize All Button**
This button moves all MAC IDs listed on the learned MAC ID list to the authorized MAC ID list.

**Authorize MAC Button**
Authorizes the MAC ID that is typed in the box to the left of this button

**Remove All Button**
Removes all authorized MAC IDs from the authorized list

**Remove Selected**
Removes the selected MAC ID from the authorized list

**VLAN setup**
Used when network bandwidth becomes critical.
VLAN can be used to eliminate traffic caused by Multicast and Broadcast Ethernet traffic. With this feature, we can partition the switch ports into different private virtual networks.

For each received packet the switch resolves the destination address and determines the appropriate port. The VLAN configuration is then checked to see if the destination address is configured to receive traffic from the source port.

Example:
Flex IO is connected to port 2 on the 8EDM, the IO is communicating with a ControlLogix on port 3. **We only want the ControlLogix on port 3** to receive traffic from the Flex IO on port 2. VLAN can be used to prevent other devices on the network from receiving packets from the Flex IO.
Our VLAN configuration would look as follows:

The Ingress Port (Source Port) 2 Will only Transmit to Egress Port (Destination Port) 3

**QoS setup**

*WARNING: Do not used on an Industrial Network; I/O devices do not support QoS Protocol*

QoS (Quality of service) allows the classification of Ethernet traffic into “high” and “low” priority queues. High priority packets will be forwarded to their destination address before a low priority packet. Packets can be classified as high or low by: MAC address, 802.1p priority tag, and or port ID.
Port based priority
When changed to High, the incoming traffic for that port is considered High Priority.

High/Low Quality weight
Establishes algorithm for switching between High and low priority Queues. The default value of 15/1 will send 15 blocks of High priority traffic then send 1 block of low priority traffic.

MAC based priority
Incoming packets are cross referenced with the MAC based QoS list, and put into the high priority queue if the destination address is on the list.

802.1P priority
Each incoming packet is examined for a valid 802.1p priority tag. If present, the packet will be put in the high priority queue if the priority tag exceeds the QoS Priority Threshold.
WARNING:
The 9300-8EDM will cycle power automatically at the end of the flash procedure. Any switching activity will be temporarily interrupted.

Upgrading with the 9300-RADES Configuration software

The 9300-RADES configuration software can be used to upgrade a 9300-8EDM.

1. Download the 9300-RADES configuration software from our website. http://www.rockwellautomation.com/services/rmd/remotedown.html
2. Fill in the Host ID, username, and password with your information (see below)
3. Select File>Utilities>Upgrade FW file first then select the new firmware file (boot.img) The unit will do a restart when the FW is done upgrading, wait about 30 seconds before going to the next step.
4. Select File>Utilities>Upgrade Web Data
5. Select File>Utilities>Upgrade Quick Start
6. The unit is now update, be sure to verify this by checking the version numbers on the home page of the 9300-8EDM

The Firmware file (boot.img), this file updates the 9300-8EDM firmware.

The Web Page Interface file (webdata.img), this file updates the 9300-8EDM web browser interface.

The Quick Start Pages file (qsdata.img), this file updates the imbedded manual accessed by clicking on the link on the home page.

Flashing the unit does not overwrite your IP address or password.
Upgrading the 9300-8EDM using the HTML Management Interface (Available with firmware version .39 and above)

The 9300-8EDM can be upgraded from its own HTML Interface. To access this feature, select Diagnostics>Firmware Upgrade and the screen shown above will be displayed.

Click the Browse button on this page and select the firmware (boot.img) file, Click Upgrade.

You will be prompted for the Administrator username and password. By default the username is uploader (lower-case) and the password is ZYPCOM (all caps). This username and password are changed by selecting Basic Configuration>Set Security from the HTML interface of the 9300-8EDM.

The unit should upgrade, when the upgrade is complete check the firmware revision on the home page to make sure the upgrade was successful.

The same process is used to upgrade the Web Browser (webdata.img) and the embedded manual (qsdata.img) files.
Username and Password Rules

Username and Password characters:

'O', 'P', 'Q', 'R', 'S', 'T', 'U', 'V', 'W', 'X', 'Y', 'Z', 'a', 'b', 'c', 'd', 'e', 'f', 'g', 'h', 'i', 'j', 'k', 'l', 'm', 'n', 'o', 'p', 'q',
'r', 's', 't', 'u', 'v', 'w', 'x', 'y', 'z',
'0', '1', '2', '3', '4', '5', '6', '7', '8', '9', '-', '.', ',', ' ',

Other rules:

Username: from 0-20 characters long (spaces count as a character)
Password: from 0-20 characters long (spaces count as a character)
Factory Reset

Factory Reset is accomplished with a small button located on the back of the unit. To access it you will need to carefully remove the plastic Din rail clip by gently lifting the tab in the center with a screwdriver and sliding the clip upward. The button is located inside the left slot, opened by the removal of the plastic clip. We have two levels of reset:

What you will need:
1. a small screwdriver
2. the AC adaptor included with the 9300-8EDM

Resetting IP address only:

To reset the IP address only:
1. With power applied, Push the reset button with a small screwdriver
2. Hold button in for 30 seconds
3. Cycle power to complete the IP reset

Your IP address will default to 192.168.1.1

Changing all settings back to default:

To reset all settings to factory default:
1. Remove power
2. Push the reset button with a small screwdriver.
3. Apply power using the AC adapter while continuing to hold the reset button
4. Hold the button in for 30 seconds
5. Cycle power to complete the reset
# Data Layout

## 9300-SEDM Diagnostics

<table>
<thead>
<tr>
<th>DINT Input</th>
<th>DINT Output</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Word 0</strong></td>
<td><strong>Word 0</strong></td>
</tr>
<tr>
<td>Bit 0</td>
<td>0 Shut down All Ports (Disables all comms)</td>
</tr>
<tr>
<td>0 Unauthorized MAC ID on Network</td>
<td>1 Shut down Port 1</td>
</tr>
<tr>
<td>1 Unauthorized MAC ID on Port 1</td>
<td>2 Shut down Port 2</td>
</tr>
<tr>
<td>2 Unauthorized MAC ID on Port 2</td>
<td>3 Shut down Port 3</td>
</tr>
<tr>
<td>3 Unauthorized MAC ID on Port 3</td>
<td>4 Shut down Port 4</td>
</tr>
<tr>
<td>4 Unauthorized MAC ID on Port 4</td>
<td>5 Shut down Port 5</td>
</tr>
<tr>
<td>5 Unauthorized MAC ID on Port 5</td>
<td>6 Shut down Port 6</td>
</tr>
<tr>
<td>6 Unauthorized MAC ID on Port 6</td>
<td>7 Shut down Port 7</td>
</tr>
<tr>
<td>7 Unauthorized MAC ID on Port 7</td>
<td>8 Shut down Port 8</td>
</tr>
<tr>
<td>8 Unauthorized MAC ID on Port 8</td>
<td>9 Reserved</td>
</tr>
<tr>
<td>9 Device Connected to Port 1 (Link Active)</td>
<td>10 Reserved</td>
</tr>
<tr>
<td>10 Device Connected to Port 2</td>
<td>11 Reserved</td>
</tr>
<tr>
<td>11 Device Connected to Port 3</td>
<td>12 Reserved</td>
</tr>
<tr>
<td>12 Device Connected to Port 4</td>
<td>13 Reserved</td>
</tr>
<tr>
<td>13 Device Connected to Port 5</td>
<td>14 Reserved</td>
</tr>
<tr>
<td>14 Device Connected to Port 6</td>
<td>15 Reserved</td>
</tr>
<tr>
<td>15 Device Connected to Port 7</td>
<td>16 Reserved</td>
</tr>
<tr>
<td>16 Device Connected to Port 8</td>
<td>17 Reserved</td>
</tr>
<tr>
<td>17 Bandwidth Alarm on Port 1</td>
<td>18 Reserved</td>
</tr>
<tr>
<td>18 Bandwidth Alarm on Port 2</td>
<td>19 Reserved</td>
</tr>
<tr>
<td>19 Bandwidth Alarm on Port 3</td>
<td>20 Reserved</td>
</tr>
<tr>
<td>20 Bandwidth Alarm on Port 4</td>
<td>21 Reserved</td>
</tr>
<tr>
<td>21 Bandwidth Alarm on Port 5</td>
<td>22 Reserved</td>
</tr>
<tr>
<td>22 Bandwidth Alarm on Port 6</td>
<td>23 Reserved</td>
</tr>
<tr>
<td>23 Bandwidth Alarm on Port 7</td>
<td>24 Reserved</td>
</tr>
<tr>
<td>24 Bandwidth Alarm on Port 8</td>
<td>25 Reserved</td>
</tr>
<tr>
<td>25 Port Shut Off by PLC</td>
<td>26 Reserved</td>
</tr>
<tr>
<td>26 IGMP Status</td>
<td>27 Reserved</td>
</tr>
<tr>
<td>27 Reserved</td>
<td>28 Reserved</td>
</tr>
<tr>
<td>28 Reserved</td>
<td>29 Reserved</td>
</tr>
<tr>
<td>29 Reserved</td>
<td>30 Reserved</td>
</tr>
<tr>
<td>30 Reserved</td>
<td>31 Reserved</td>
</tr>
<tr>
<td>31 Reserved</td>
<td><strong>Word 1</strong></td>
</tr>
<tr>
<td>Multicast Connections Active</td>
<td><strong>Word 1</strong></td>
</tr>
<tr>
<td><strong>Word 2</strong> TCP Connections Active</td>
<td><strong>Word 2</strong> TCP Connections Active</td>
</tr>
<tr>
<td><strong>Word 3</strong> Bandwidth Used Port 1 (%)</td>
<td><strong>Word 3</strong> Bandwidth Used Port 1 (%)</td>
</tr>
<tr>
<td><strong>Word 4</strong> Bandwidth Used Port 2 (%)</td>
<td><strong>Word 4</strong> Bandwidth Used Port 2 (%)</td>
</tr>
<tr>
<td><strong>Word 5</strong> Bandwidth Used Port 3 (%)</td>
<td><strong>Word 5</strong> Bandwidth Used Port 3 (%)</td>
</tr>
<tr>
<td><strong>Word 6</strong> Bandwidth Used Port 4 (%)</td>
<td><strong>Word 6</strong> Bandwidth Used Port 4 (%)</td>
</tr>
<tr>
<td><strong>Word 7</strong> Bandwidth Used Port 5 (%)</td>
<td><strong>Word 7</strong> Bandwidth Used Port 5 (%)</td>
</tr>
<tr>
<td><strong>Word 8</strong> Bandwidth Used Port 6 (%)</td>
<td><strong>Word 8</strong> Bandwidth Used Port 6 (%)</td>
</tr>
<tr>
<td><strong>Word 9</strong> Bandwidth Used Port 7 (%)</td>
<td><strong>Word 9</strong> Bandwidth Used Port 7 (%)</td>
</tr>
<tr>
<td><strong>Word 10</strong> Bandwidth Used Port 8 (%)</td>
<td><strong>Word 10</strong> Bandwidth Used Port 8 (%)</td>
</tr>
<tr>
<td><strong>Word 11</strong> Bandwidth Scaling Factor</td>
<td><strong>Word 11</strong> Bandwidth Scaling Factor</td>
</tr>
</tbody>
</table>
Adding the 9300-8EDM to RSLogix5000 ver. 13 and under

The 9300-8EDM can be used with the Logix platform only. Follow the steps shown below to successfully add the 9300-8EDM to your Logix5000 ver. 13 application using the Generic Profile.

1. Right-Click on your Logix Ethernet card under the I/O configuration section of your program, and select New Module

2. Select the Generic Ethernet Module from the list
3. Enter a name for the 9300-8EDM; Enter the IP address of the 9300-8EDM; Enter the Assembly instance and size for Input, Output and Configuration as shown below; click next.

4. Enter a RPI of 100ms to 700ms (700ms recommended), then click Finish.
5. You will now see the 9300-8EDM under your I/O configuration.

6. You can now use the 9300-8EDM I/O in your program, See Appendix D for the Data Layout.
Adding 9300-8EDM into a Logix Application using it’s AOP

The 9300-8EDM can be scanned with the Logix platform only. Follow the steps shown below to successfully add the 9300-8EDM to your Logix5000 ver. 15 and above application using the Add on Profile.

Add on profiles are required to be installed before they can be used in the Logix programming environment. Therefore, the first step will be to install the Add on profile onto the computer that will be used to program with Logix 5000.

To install the AOP follow these steps:
1. Check the Installation documentation included with the AOP to determine the necessary firmware version for the 9300-8EDM. If you do not have the minimum version of 9300-8EDM firmware, upgrade your unit before proceeding. Appendix A covers the upgrade procedure for the 9300-8EDM. To obtain the latest firmware check the 9300-8EDM’s website or contact Technical Support.
2. Save the zip file on your hard drive and unzip the Add on Profile archive.
3. Run the Batch file “install” that is located in the root directory.
4. The installation wizard for Add on profiles will open
5. Agree to the licensing terms and click next, click next to install the Add On Profile.

Once the Add on Profile is installed, it can be used in a Logix 5000 ver. 15 and above program. To add a 9300-8EDM into your Logix program, follow these steps:

1. Right-Click on your Logix Ethernet card under the I/O configuration section of your program, and select New Module

2. Select the 9300-8EDM from the list. It will be under the communications tab in the list.

3. Give the Module a name in your program and enter it's IP address. Click OK to add the module to your program.
The Add on profile allows for configuration of:

**General Page**

![Configuration Software Screenshot](image)

**Name:** Required field gives the module a descriptive name in your Logix program

**Description:** Optional field used for descriptive text

**Module Definition:** Leave at default unless documentation indicates otherwise

**IP Address/Hostname:** Required field must be populated with the IP address of the 9300-8EDM (note: Logix will not be able to talk to the module unless the 9300-8EDM is set for the IP address in this field)

Available offline only

**Connection Tab**

![Connection Tab Screenshot](image)
Requested Packet Interval (RPI): Default value is 700mS, supports RPI from 50-750mS
This is a multicasting device, because it does not need a fast RPI to fulfill its purpose we recommend a slow RPI to minimize network impact. Available online and offline

Inhibit Module: Module will not be scanned by the Logix Controller when this is checked. Available online and offline

Major Fault if connection fails in run mode: When checked, a communication failure with the 9300-8EDM will generate a major fault in the controller. When unchecked, a communication failure will generate a minor fault. Available online and offline

Module Info Tab

Displays identification and status of the 9300-8EDM, the information will only be displayed while the controller is in run mode.

Refresh: refreshes identification and status on this page

Reset Module: resets the 9300-8EDM (communications to the module will be interrupted)
Port Configuration Tab

Network Configuration: Use to configure network settings

*Box Name:* Descriptive name for the unit

*IP Address:* IP address of the 9300-8EDM must match the IP address on the General page

*Subnet Mask:* The subnet mask is used to determine where the network number in an IP address ends and the node number in an IP address begins.

*Gateway Address:* Address of router on the network (if one exists, if not leave this at 0.0.0.0)

*Enable Bootp Client:* Allow the 9300-8EDM IP address to be assigned by a bootp server

*Enable DNS:* If using hostnames on the network DNS must be enabled in the 9300-8EDM

Port Configuration: Use to configure port settings

*Select Port Number:* Select the port to be configured

*Auto-negotiate port speed and duplex:* must be unchecked to manually override the port settings

*Current Link, Port speed, Duplex:* populated with settings from the selected port

*Select Port Speed:* Only active when auto-negotiate is unchecked

*Select Duplex:* Only active when auto-negotiate is unchecked

*Set Button:* Must be clicked to load settings from this page

*Refresh Button:* Reloads settings from the 9300-8EDM
Port Diagnostic Tab

Select Port Number: Select the port counters to be displayed
Clear Counters: Clears the counters

IGMP

Enable IGMP: Enables IGMP feature in the 9300-8EDM (for more on IGMP see page 15 of this manual)
Version: Select from version 1 or version 2 (for more information see page 15 of this manual)
Query Period: Select the interval rate that the network will be queried for IGMP information
Note: Settings of the IGMP tab will overwrite settings made on the HTML management interface. If you are scanning the 9300-8EDM with Logix use this tab to configure IGMP to avoid confusion.

Alarming Tab

Bandwidth Alarm
Configuration of bandwidth alarming and displays graph of current network traffic, the bars will be red if the port is in alarm and green if it is not (See page 33 for more information on these settings. The bandwidth alarm requires a point of comparison, this must be set in the HTML interface.) **Unlike IGMP, this can be enabled from here or the HTML interface**

MAC ID Management
Configuration of MAC ID management and a display the alarm status on each port (See page 40 for more information on these settings) **Unlike IGMP, this can be enabled from here or the HTML interface**

Set button: Loads settings from this page into the 9300-8EDM
Refresh button: Re-populates this page with settings from the 9300-8EDM
Fault/Action Tab

This page controls the port behavior when the 9300-8EDM loses communications with the Logix controller or the Logix controller goes into program mode. This feature can be used to disable ports while the Logix controller is in run mode and enable them when the Logix controller is offline.

**Communication Fault Behavior:** (Default Value: Enable All ports)
- **Enable all ports** when the 9300-8EDM loses communications with the PLC. If the PLC is disabling a port, it will be enabled if communications with the PLC are lost.
- **Hold last state** when the 9300-8EDM loses communications with the PLC. If a port is disabled by the PLC is will continue to be disabled when communication with the PLC are lost. To re-enable all of the ports the 9300-8EDM will require a power cycle.
- **Apply Safe State values to ports** when communications with the PLC are lost. Port status can be changed when the communications to the PLC are lost.

**Program Mode Behavior:** (Default Value: Enable All ports)
- **Enable all ports** when the Logix controller is put in program mode. If the Logix controller is disabling a port, it will be enabled if the Logix controller is put in program mode.
- **Hold last state** when the Logix controller is put in program mode. If a port is disabled by the PLC is will continue to be disabled when the PLC is put in program mode. To re-enable all of the ports the 9300-8EDM will require a power cycle.
- **Apply Safe State values to ports** when the Logix controller is put in program mode. Port status can be changed when the Logix controller is put in program mode.
G

Downloading Configuration

The 9300-8EDM has the ability to accept its configuration from a file that can be stored on a PC. This is useful if the same configuration must be used in multiple units. This file can be retrieved from a unit and downloaded to a unit.

Uploading and Downloading configuration from a 9300-8EDM using the Configuration Utility

Downloading Configuration from the 9300-8EDM and saving it on your PC

1. Download the 9300-RADES configuration software from our website. http://www.rockwellautomation.com/services/rmd/remotedown.html
2. Fill in the Host ID, username, and password with your information (see below) default settings of the 9300-8EDM (IP: 192.168.1.1, Port: 21, username: uploader, password: ZYPCOM)
3. Click Download CFG, a list of files should appear in the “Files on Device:” box.
4. Select File>Save As and give the file a descriptive name and select a location for the file
5. Click save
Uploading Configuration from your PC to the 9300-8EDM

1. Download the 9300-RADES configuration software from our website.
   http://www.rockwellautomation.com/services/rmd/remotedown.html
2. Fill in the Host ID, username, and password with your information (see below) default settings of the 9300-8EDM (IP: 192.168.1.1, Port: 21, username: uploader, password: ZYPCOM)
3. Select File>Open and Select the Configuration file on your computer
4. Click Open
5. To send the file to a default 9300-8EDM make sure the IP address, Port, username, and password are all at default settings (see step two)
6. Click Upload CFG to send the configuration to the unit.